RETScreen® Plus Software Tutorial

Rene E. Ganoe
Science Systems and Applications, Inc., Hampton, Virginia

Paul W. Stackhouse, Jr. and Russell J. DeYoung
Langley Research Center, Hampton, Virginia

November 2014
NASA STI Program . . . in Profile

Since its founding, NASA has been dedicated to the advancement of aeronautics and space science. The NASA scientific and technical information (STI) program plays a key part in helping NASA maintain this important role.

The NASA STI program operates under the auspices of the Agency Chief Information Officer. It collects, organizes, provides for archiving, and disseminates NASA’s STI. The NASA STI program provides access to the NASA Aeronautics and Space Database and its public interface, the NASA Technical Report Server, thus providing one of the largest collections of aeronautical and space science STI in the world. Results are published in both non-NASA channels and by NASA in the NASA STI Report Series, which includes the following report types:

- **TECHNICAL PUBLICATION.** Reports of completed research or a major significant phase of research that present the results of NASA Programs and include extensive data or theoretical analysis. Includes compilations of significant scientific and technical data and information deemed to be of continuing reference value. NASA counterpart of peer-reviewed formal professional papers, but having less stringent limitations on manuscript length and extent of graphic presentations.

- **TECHNICAL MEMORANDUM.** Scientific and technical findings that are preliminary or of specialized interest, e.g., quick release reports, working papers, and bibliographies that contain minimal annotation. Does not contain extensive analysis.

- **CONTRACTOR REPORT.** Scientific and technical findings by NASA-sponsored contractors and grantees.

- **CONFERENCE PUBLICATION.** Collected papers from scientific and technical conferences, symposia, seminars, or other meetings sponsored or co-sponsored by NASA.

- **SPECIAL PUBLICATION.** Scientific, technical, or historical information from NASA programs, projects, and missions, often concerned with subjects having substantial public interest.

- **TECHNICAL TRANSLATION.** English-language translations of foreign scientific and technical material pertinent to NASA’s mission.

Specialized services also include organizing and publishing research results, distributing specialized research announcements and feeds, providing information desk and personal search support, and enabling data exchange services.

For more information about the NASA STI program, see the following:

- Access the NASA STI program home page at [http://www.sti.nasa.gov](http://www.sti.nasa.gov)

- E-mail your question to help@sti.nasa.gov

- Fax your question to the NASA STI Information Desk at 443-757-5803

- Phone the NASA STI Information Desk at 443-757-5802

- Write to:
  STI Information Desk
  NASA Center for AeroSpace Information
  7115 Standard Drive
  Hanover, MD 21076-1320
RETScreen® Plus Software Tutorial

Rene E. Ganoe
Science Systems and Applications, Inc., Hampton, Virginia

Paul W. Stackhouse, Jr. and Russell J. DeYoung
Langley Research Center, Hampton, Virginia

November 2014
Acknowledgments

This work was performed in collaboration between the NASA Langley Research Center Science Directorate and the RETScreen® International team of CanmetENERGY Natural Resources Canada. Mr. Greg Leng and Mr. Urban Ziegler of RETScreen were very helpful in providing guidance and advice for how to use the tools for buildings at the NASA Langley Research Center. We also acknowledge collaboration with the Research Directorate including the NASA LaRC energy manager Mr. Robert Charles and Ms. Joan Hughes. NASA Headquarters funded this project through the Climate Adaptation Science Investigator Program.

The use of trademarks or names of manufacturers in this report is for accurate reporting and does not constitute an official endorsement, either expressed or implied, of such products or manufacturers by the National Aeronautics and Space Administration.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>i</td>
</tr>
<tr>
<td>Abstract</td>
<td>iv</td>
</tr>
<tr>
<td>1. Background and Purpose</td>
<td>1</td>
</tr>
<tr>
<td>1.1 Tutorial scope</td>
<td>2</td>
</tr>
<tr>
<td>2. Getting Started</td>
<td>2</td>
</tr>
<tr>
<td>2.1 System requirements</td>
<td>2</td>
</tr>
<tr>
<td>2.2 Start a new project</td>
<td>3</td>
</tr>
<tr>
<td>3. Data Inputs</td>
<td>4</td>
</tr>
<tr>
<td>3.1 Consumption/production inputs</td>
<td>5</td>
</tr>
<tr>
<td>3.2 Factors of Influence</td>
<td>8</td>
</tr>
<tr>
<td>3.2.1 Weather</td>
<td>8</td>
</tr>
<tr>
<td>3.2.2 Production level</td>
<td>9</td>
</tr>
<tr>
<td>3.2.3 Occupancy</td>
<td>10</td>
</tr>
<tr>
<td>3.3 Data Processing</td>
<td>10</td>
</tr>
<tr>
<td>3.3.1 Degree days</td>
<td>10</td>
</tr>
<tr>
<td>3.3.2 Solar insolation</td>
<td>11</td>
</tr>
<tr>
<td>3.3.3 Merge data</td>
<td>12</td>
</tr>
<tr>
<td>3.3.4 Apply filters</td>
<td>12</td>
</tr>
<tr>
<td>3.3.5 Column options</td>
<td>13</td>
</tr>
<tr>
<td>4. Analytics</td>
<td>13</td>
</tr>
<tr>
<td>4.1 Establishing a Baseline</td>
<td>13</td>
</tr>
</tbody>
</table>
Abstract

Greater emphasis is being placed on reducing both the carbon footprint and energy cost of buildings. A building’s energy usage depends upon many factors one of the most important is the local weather and climate conditions to which it’s electrical, heating and air conditioning systems must respond. Incorporating renewable energy systems, including solar systems, to supplement energy supplies and increase energy efficiency is important to saving costs and reducing emissions. Also retrofitting technologies to buildings requires knowledge of building performance in its current state, potential future climate state, projection of potential savings with capital investment, and then monitoring the performance once the improvements are made. RETScreen Plus is a performance analysis software module that supplies the needed functions of monitoring current building performance, targeting projected energy efficiency improvements and verifying improvements once completed. This tutorial defines the functions of RETScreen Plus as well as outlines the general procedure for monitoring and reporting building energy performance.
1. Background and Purpose

Development of strategies to mitigate the impacts associated with climate change has become an important topic of study [1]. One facet of climate change mitigation involves minimizing the carbon footprint associated with anthropogenic energy consumption [2]. Studies have shown that the building sector is responsible for approximately 40% of the total energy consumed globally; thus, the improvement of building energy efficiency is especially important [3]. Reducing the carbon footprint and thus the energy associated with a building allows more to be spent on a given building’s operations and infrastructure, even with higher energy cost. Both energy and carbon reduction can be achieved through introduction of renewable energy technologies (RETs), also through retrofit alternatives and alteration of operational procedures [4]. Additionally, on-going monitoring of energy usage in new and existing buildings is a key to reducing primary energy intensity, as demonstrated in the IPCC (Intergovernmental Panel on Climate Change) Fifth Assessment Report [5]. A comprehensive decision support analysis program (as described in the tutorial) to manage building energy usage near real-time and evaluate the energy performance of new energy technologies on the current building sector would facilitate the integration of RETs into current buildings resulting in decreased overall energy usage. Furthermore, this would provide management with the decision support tools necessary to strategically develop projects for future efficiency improvements.

RETScreen® International was developed by Natural Resources Canada’s CanmetEnergy Diversification Research Laboratory (CEDRL) in collaboration with partners such as Renewable Energy and Energy Efficiency Partnership (REEEP), National Aeronautics and Space Administration (NASA), the United Nations Environment Programme (UNEP), and the Global Environment Facility (GEF). The RETScreen Suite is a comprehensive software tool that provides users with decision support to model and analyze clean energy projects and energy efficiency improvements. RETScreen is well-established with over 420,000 users in 222 countries, and software available in 35 languages. To date, RETScreen is directly responsible for an estimated $8 billion in user energy savings; furthermore, use of the software indirectly contributes to a conservative estimate of 20 million ton per year reduction in greenhouse gas emissions [6].

The RETScreen Suite is comprised of two modules, RETScreen 4 and RETScreen Plus. RETScreen 4, an Excel-based software package facilitates analysis of clean energy projects and allows users to develop energy efficient project models and generate a five-step analysis report including 1) energy usage, 2) cost, 3) emissions, 4) financial benefits, and 5) risk associated with the project. Prior to the development of energy efficiency analysis, the initial state of the building must be well established, thus creating a base case to evaluate future energy usage improvements. To this end, RETScreen developed the Performance Analysis Module called RETScreen Plus, which employs the monitoring, targeting, and reporting (MT&R) of current building performance with integration of meteorological and solar insolation data. This module facilitates mapping energy usage over time to demonstrate performance changes due to improvements or building alterations; furthermore, it provides an approach to quantitatively measure building efficiency. RETScreen Plus also utilizes measurement and verification (M&V)
functions which provide initial decision support by gauging financial feasibility prior to implementation of energy efficiency measures or renewable technology systems [7].

The utility of RETScreen Plus is that it addresses a host of issues associated with retrofitting RETs into existing buildings:

- energy use when weather parameters are changing
- efficacies of capital investments, such as system refurbishments or new installations
- predominant influences driving energy usage of a particular building
- impact of changes in personnel schedules or equipment to the overall energy efficiency of the building
- changes in yearly energy usage trends
- impact of small-scale retrofitting (i.e. lighting) or building envelope (i.e. insulation) on energy usage
- energy and financial savings associated with implementation of an onsite renewable energy technology

RETScreen Plus answers these issues quantitatively, in terms of energy savings or losses and financial cost, to authenticate the validity or potential of energy improvement measures. Energy monitoring using RETScreen Plus has previously been demonstrated as a valuable instrument in managing energy usage in commercial, residential and industrial applications [8, 9].

1.1 Tutorial scope

This tutorial will provide a brief overview of the basic user functions of RETScreen Plus software. RETScreen 4, the Excel based clean energy analysis component of the software suite is not covered in this tutorial. RETScreen Plus provides the necessary prefeasibility analysis prior to implementation of clean energy projects. Following the software walkthrough, the tutorial will provide specific procedures outlining the methodologies for setting up building energy monitoring and energy performance analyses.

2. Getting Started

2.1 System requirements

The RETScreen Software Suite is available as a free download from the RETScreen International website (www.retscreen.net) with a valid email address. System requirements for RETScreen Plus include Microsoft Windows XP or higher, and Microsoft .NET Framework 4 or higher (Full Profile version) [3].
2.2 Start a new project

To begin, open RETScreen Plus and a blank project will be created by default. The program opens on the ‘Start’ tab, located on the top bar. Complete the fields within the ‘Project Information’ section, and then press the ‘Select climate data location’ button, to open the climate database for site location selection, as shown in Figure 1.

![Figure 1. Start page for project information and site location inputs.](image)

Within the climate database window, shown in Figure 2, the climate data location can be designated via the ‘Map’ or ‘Data’ tabs. From the ‘Map’ tab, drag the project location icon to the appropriate geographical location, i.e. the latitude and longitude coordinates where the performance analysis is being conducted. The dropdown list provides climate data locations arranged by proximity to the project location, which are either ‘Ground’ or ‘NASA’ climate data locations. Generally, the NASA station nearest to the project location is selected as the climate data location in order to calculate a “normal year” based on 20 years historical data. The daily weather parameters generated by the "download NASA satellite data" function are provided according to the geographical coordinates of the project location, and are therefore independent from the climate data location. Double click on the desired station in the drop down list, so the climate data location icon should now be on the chosen location. Submit these changes by pressing the green check command at the bottom of the panel.
3. Data Inputs

Go to the ‘Data’ tab on the top bar (see Fig 1), to open the section to input which information is related to the project. There are 3 basic steps to input and manipulate the data: (1) Consumption/Production, (2) Factors of influence, and (3) Data Processing.
3.1 Consumption/production inputs

Data input Step 1 involves retrieval and tabulation of the metered consumption and/or production data relevant to the building or system undergoing energy performance analysis or monitoring.

The available functions for data input include a user defined table and pre-defined tables for electricity consumption, fuel consumption, water consumption, electricity production, shown in Figure 3.

![Figure 3. Data Step 1 functions for input of various types of energy data.](image)

The recommended and most efficient method of data input in RETScreen Plus is to import a file directly as a new data table. To import metered data, choose ‘Import from file’ under the ‘User-defined’ drop down tab. Using this method, the file format must be Microsoft Excel or comma delimited. The imported data must include a field indicating the Date (Day, Month, Year). Click ‘Import from file’ under the ‘Data’ tab in the top bar and select the file to be imported. This prompts a dialogue box to format the imported data, shown in Figure 4.
The drop-down tabs above each column indicate the data type (pre-defined options or user-defined) or mark columns not to include in the import. After confirming these options, a second dialogue box will appear with fields to indicate parameters of the data set, shown in Figure 5. The dialogue box sorts each field into individual columns, and provides boxes to specify Name, Units, and Aggregation method.
The aggregation method is an important parameter, which indicates how values are grouped when merging data (Section 3.3) over a different time period. Refer to Table 1 for aggregation methods for various data parameters.

<table>
<thead>
<tr>
<th>Aggregation model</th>
<th>Model method</th>
<th>Parameter</th>
</tr>
</thead>
</table>
| Maximum           | The maximum value for the corresponding period will be calculated. | -Maximum production level  
-Power demand |
| Minimum           | The minimum value for the corresponding period will be calculated. | -Minimum occupancy |
| Average           | The average value for the corresponding period will be calculated. | -Solar insolation  
-Relative humidity  
-Temperature |
| Sum               | The sum of values for the corresponding period will be calculated. | -Energy production  
-Energy consumption  
-Heating and cooling degree days |
| None              | Data will not be aggregated. | -Text |

Table 1. Description of aggregation method types and recommended use for each type.

An example of a ‘User-defined’ table, in this case daily metered photovoltaic electric production, is shown in Figure 6.
3.2 Factors of influence

Data Step 2 involves creating tables for possible energy drivers, or factors that influence the consumption/production energy data. The available options for energy driver input include ‘Weather’, ‘Production level’ and ‘Occupancy’.

3.2.1 Weather

Solar irradiance and meteorological parameters are typically the primary influencing factors impacting electricity consumption and production, as well as other types of fuel consumption. Accordingly, for most applications weather is the first driver to be addressed. Selecting the ‘Weather’ command on the toolbar adds a new data table to the project set, and simultaneously adds a new option to the toolbar.
Selecting ‘Download NASA satellite data’ will open a prompt, shown in Figure 7, to specify the period of climate data desired. The climate data is automatically returned to the weather table as daily measurements and individual parameters can be merged to tables containing consumption/production data. If the consumption/production data is aggregated weekly or monthly, then the weather parameters are automatically adjusted to match that time period.

Figure 7. Dialogue box for selecting time period of NASA satellite data.

With the weather data table selected in the side bar, choose the ‘Filter’ option on the toolbar, choose ‘Group by’ and aggregate accordingly. With the weather data available, the Degree-days option on the toolbar can be used to calculate heating degree-days (HDD) and cooling degree-days (CDD), defined as the difference between a set temperature and the average daily temperature (reference temperature 16°C and 18°C, respectively). HDD and CDD are the primary drivers for electric usage in most applications, as these are the largest factors driving heating, ventilation, and air conditioning (HVAC) usage for management of ambient indoor temperature needs. Relative humidity, min/max temperature and windspeed are other meteorological factors of influence that can be applied to the analysis, when applicable. These data parameters are derived from a NASA data assimilation model that uses satellite and other measurements to optimize solutions for global surface and atmospheric profile weather information. Daily solar radiation (or insolation) is an important driver when assessing a photovoltaic system. The insolation data pulled from the NASA data set is derived from satellite observations and given as the insolation incident on a horizontal surface; however, RETScreen has a function to calculate the specific system insolation based on the PV system configurations—tilt angle (slope), azimuth angle, and solar tracking mode.

3.2.2 Production level

In addition to meteorological and solar data, the building’s production level (such as manufactured products or energy production from a solar photovoltaic panel system) is an influencing driver that can be factored into the analysis. Any building that produces quantifiable output metered by a fixed unit of measure can be utilized for production level input. Production level data, when available, provides another level of detail to explain variance in building energy usage trends.
3.2.3 Occupancy

Building occupancy is another key driver of energy usage. The addition or removal of any persons in small office buildings, or highly fluctuating numbers of personnel due to various schedules or seasonal employment, can affect the building electric load. Changes in occupancy can account for energy fluctuations unexplained by weather conditions or production level. By choosing ‘Occupancy’ a new data table is created to account for occupancy over any given time period. The specific unit used to measure occupancy can be customized as necessary.

3.3 Data processing

Step 3 involves data processing using the options shown in Figure 8, most of which have been discussed in previous sections.

Figure 8. Available functions for data processing.

The functions include the ‘Degree-days’ command for appending degree-day data to a specified data table, and the ‘Daily solar radiation-tilted’ command for converting horizontal insolation to insolation on a tilted surface (i.e. solar panel). Other functions of the data processing step include the ‘Merge’ command, which enables data columns from one table to be migrated to another table, and the ‘filter’ function to group data by specific time scales.

3.3.1 Degree days

Heating and cooling degree days are important drivers of energy usage, particularly in buildings with heating and air conditioning systems. There are two methods for calculating degree days, which both use the air temperatures given by the weather data set. Method 1 uses average air temperature; Method 2 uses min/max air temperatures and is more complex. Method 2 provides better results for daily metered data; however, for weekly, monthly or yearly data sets, method 1 is sufficient. The increased complexity of Method 2 calculations translates to increased resolution detail; therefore, it is useful when the actual air temperatures oscillate around the reference temperature.
Figure 9. Dialogue box to specify degree-day calculation methods and reference temperatures.

The reference temperatures for calculating heating and cooling degree days vary among climates, building types, and construction types; therefore, it is important to ensure the reference temperature is appropriate. Initially, set the heating and cooling degree day reference temperatures based on best guess, or charts can be found through a web search. Once a regression analysis has been performed (see section 4, Analytics) the reference temperatures can be adjusted to optimize the $R^2$ value. To adjust the degree day calculations, select the ‘Degree days’ icon. In the dialogue box, shown in Figure 9, choose ‘heating degree-days’, ‘cooling degree-days’, or both; select the data table containing weather data; select the desired calculation method; and set reference temperatures.

3.3.2 Solar insolation

The solar data provided in the weather data set is daily insolation estimated on a horizontal surface. The conversion from horizontal surface to tilted surface is complex, but there is a function in RETScreen to do the calculations.

Figure 10. Dialogue box for converting horizontal insolation to insolation on a tilted surface.

Most solar arrays perform at a tilt, and sometimes have tracking modes. To convert the RETScreen insolation data to account for the specific PV system characteristics, click the
‘Daily solar radiation-tilted’ icon and complete the ‘Solar tracking mode’, ‘Slope’ and ‘Azimuth’ dialogue box entries, shown in Figure 10.

3.3.3 Merge data

Prior to generating graphs in the analytics section, all data utilized in each graph must be available within the same data table. For example, all meteorological parameters that act as energy consumption drivers must be merged into the energy consumption table. To merge data the two sets must have the same time step, with the exception of daily data, which can be merged into data sets aggregated weekly, monthly or yearly. To merge data, click ‘Merge’ on the Data toolbar, select data array to be merged, and indicate the destination data table, shown in Figure 11.

![Figure 11. Dialogue box to merge data sets.](image)

3.3.4 Apply filters

Any data table can be aggregated on various time scales (daily, weekly, monthly, yearly) depending on the type of data and/or the required temporal resolution of the analysis; however, it is recommended that filtering is only done after all merging has been performed. For example, if the metered energy data was daily electricity, but the goal was to set up weekly monitoring, then the original data table could be aggregated (by average, sum, min/max) to produce a new table with weekly values. It is recommended to first perform the analytics using the full data set and then filter to perform a secondary analysis at a more coarse time scale, if desired. The method of aggregation is the method that was specified for each column when the original data was imported. To filter data, click the ‘Filter’ drop-down command, click ‘Group by’ and select the desired time scale.

Additionally, the ‘Filter’ command can be used to indicate how to deal with missing data. Click the ‘Filter’ drop-down and select ‘Missing data’. The dialogue box brings up the data table and
highlights any missing cell values. The options are as follows: ‘ignore’, ‘average’, ‘interpolate’, ‘repeat’, ‘delete’. These options can be applied to ‘All’ or chosen cells can be handled individually.

3.3.5 Column options

Data columns can be added to an existing data tab if manipulation of the data is needed. This feature for data manipulation can be utilized for a number of operations, such as performing unit conversions/algebraic calculations on given parameters, generating sub metering if it is not available, or adding a hypothetical baseline to predict performance given a fixed set of conditions. For example, if a building utilizes electric and steam, but the two consumption sources have been imported separately, then a new column could be created for total energy usage. With the appropriate data tab highlighted, click the ‘Insert column’ drop down list and select ‘User defined’. In the dialog box, enter the new column name, units, aggregation method, and then select the ‘Calculator’ option. Data column names are provided in a list, which upon selection are incorporated into the formula bar and should be used in conjunction with the calculator functions. For this example, the formula would simply be: {Electric usage} + {Steam usage}. Click the green check to initiate the command, and RETScreen Plus generates the new column and data values.

4. Analytics

The first step in data analytics is to identify the factors of influence that drive energy production or consumption using a technique known as regression analysis.

4.1 Establishing a baseline

To begin data analytics, a baseline must be established by generating a regression analysis. The regression analysis establishes a relationship between the dependent variable and the independent variables through a mathematical function and creates a regression line representing the baseline predicted value. The fit of the regression line indicates how well the independent variables explain the outcome of the dependent variable. Modeling this relationship using multiple factors of influence provides a multivariate regression analysis and generates a more complex mathematical equation. Generally, there are multiple factors of influence driving energy usage or production, so establishing a mathematical relationship with all relevant drivers decreases the unexplained variance in the analysis.
To generate a baseline, from the ‘Analytics’ tab in the top bar, click the ‘Baseline’ drop down command and choose ‘regression analysis’. A new window, shown in Figure 12, will prompt to choose a name, and choose the data table to be analyzed. The dependent variable (y) is be the measured parameter such as energy consumption or production; the independent variables (x) are any factors of influence that drive the electricity consumption.

Figure 12. Dialogue box to indicate baseline parameters, including data set, variables, and methods to use.
After choosing the data set and variables for analysis, the analyzed data set will be added in the ‘Analytics’ section sidebar, named ‘Baseline – Regression’ by default. Within this set there are multiple tabs available with various information, including ‘Time series’, ‘X-Y scatter’, ‘Line’, and ‘Details’. The ‘X-Y scatter’ tab is only available for bivariate regression analyses (linear) as shown in Figure 13.

Generating a baseline with 2 or more independent variables (i.e. multivariate) produces a non-linear regression line. Examples of a multivariate regression analysis under the ‘Time series’, ‘Line’, and ‘Details’ tabs are shown in Figure 14, 15 and 16, respectively.
Figure 14. Screenshot of the ‘Time series’ tab for a nonlinear regression analysis of daily PV energy production vs. daily solar radiation and daily module temperature. Note that the time series for the dependent variable is placed on the left axis and the time series for the independent variables stack on the right axis.
Figure 15. Screenshot of the ‘Line’ tab for a nonlinear regression analysis of daily PV energy production vs. daily solar radiation and daily module temperature.
Figure 16. Screenshot of the ‘Details’ tab for a nonlinear regression analysis of daily PV energy production vs. daily solar radiation and daily module temperature.

The ‘Details’ tab of the regression analysis includes the information about the mathematical equation generated to model the relationship between energy consumption/production and the factors of influence. The ‘Details’ tab provides the equation chosen, the regression result statistics, and the coefficient results. The ‘Select equation’ function provides a number of equations to model the regression; however, it is recommended to use the default equation chosen by the program. The coefficient results include the coefficient Value, standard error, and Prob(t) for each variable in the equation. The Prob(t) is a 2-tailed p-value that indicates the level of confidence that the coefficient is statistically significant, where $p < 0.05$ indicates 95% confidence. In the Figure 16 example, the coefficient ‘a’ is a constant; therefore, the coefficient results of ‘a’ do not hold critical meaning to the regression.

4.2 Comparison functions

After the regression analysis determines the baseline energy usage or production, there are several comparison functions to quantify energy usage.
4.2.1 Cumulative sum

Choosing the ‘Cumulative sum’ function generates a running sum of the difference between the actual energy and the baseline predicted energy over a time series, shown in Figure 17. For energy consumption analysis, positive deviation from baseline indicates efficiency loss (e.g. energy usage greater than predicted energy production) and negative deviation indicates efficiency gain. (e.g. energy production greater than energy usage). For energy production analysis (i.e. PV system), positive deviation from baseline indicates efficiency gain and negative deviation indicates efficiency loss. A linear trend in the CUSUM indicates a period of minimal deviation in the difference between actual energy and predicted energy; thus, providing a high correlation between energy usage and energy drivers, and a minimal amount of unexplained variance in the analysis.

Figure 17. Cumulative sum (CUSUM) plot using a baseline generated by the regression analysis of PV electricity production vs. daily solar radiation over the time series from February 2012-March 2014.
4.2.2 Control chart

The control chart shows the variance (% or actual difference) between predicted and actual energy consumption or production. Specific target values other than the baseline values can be indicated to verify how close the energy performance comes to a desired target. This allows periods of poor or superior performance to be identified. To generate the control chart, select the desired regression analysis in the ‘Analytics’ sidebar and choose ‘Control chart’ under the ‘Analytics’ tab on the top bar. An example control chart is shown in Figure 18. Variance provided as a percentage is often misleading; therefore, viewing the control chart as ‘Actual – baseline’ is recommended in order to quantify the variance in unit value.

Figure 18. Example of a control chart using the ‘Actual- Baseline’ method.
4.2.3 Measurement and verification

The ‘Measurement and verification’ function shows the actual energy consumption side by side with the generated baseline. This allows ongoing energy monitoring to track real-time net savings from energy efficiency measure implementation.

4.3 Analytics tools

The Analytics tools provide various graphs and the option to incorporate the project into RETScreen 4 databases.

4.3.1 Graphs

Click the ‘Graph’ drop-down under the ‘Analytics’ tab to create any of the following graphs: annual bar graph, monthly bar graph, bar and pie charts, time series graph, climate data graph, and moving graph.

4.3.2 RETScreen 4

After using RETScreen Plus to analyze building performance and establish a baseline, RETScreen 4 allows users to develop project models and generate a five-step analysis report including energy usage, cost, emissions, financial benefits, and risk associated with the project. To link a RETScreen Plus project with RETScreen 4 or access databases, click ‘RETScreen 4’ under the ‘Analytics’ tab and choose from the drop-down list: Project database, benchmark database, or Start RETScreen 4.

4.4 Analytics options

The influencing drivers of energy consumption and production often change by seasons or over specified periods of time. The ‘Define season’ function allows different baselines to be established throughout the year to coincide with the corresponding driver. For example, cooling degree days are often the key energy driver in the summer and likewise, heating degree days are the key energy driver during winter. The seasons can be defined such that different regression analysis are performed depending on the time of year. To use this feature, select the regression analysis to be adjusted, click the ‘Define season’ button, and set the dates which maximize each drivers influence.
5. Reporting

Perhaps the most important part of an energy monitoring routine is the effective communication of results to decision-makers in order to facilitate changes for optimizing performance. Within most organizations, the type of information needed for monitoring building energy performance varies with level and responsibility of individuals. The Reporting Worksheet within the RETScreen Plus provides a selection of high-level standardized reports, as well as detailed customizable reports, shown in Figure 19. This customization of reporting enables the intended audience to have only relevant information, which in turn facilitates decision support and ultimately results in taking appropriate actions toward energy efficiency.

![Figure 19. Cover page of RETScreen Plus report generated for facility operators.](image)

5.1 Create report

To generate a report, select the ‘Reporting’ tab on the top bar and choose the applicable template. The available templates are designated for: Senior decision-makers, Managers, Facility operators, or Custom. Upon choosing a template, RETScreen automatically renders all relevant figures/data into a report format.

5.2 Edit report

The specific items included by default in the report are determined by the chosen template, however there are options to insert notes, images, maps,
and individually specify the figures and data to include. Choosing the ‘Insert analysis’ command allows any of the graphs generated in the project to be included in the report. The pages of the report can be sorted in the side panel by dragging the page to the desired location. To change title of each page, right-click on that page within the side panel and chose ‘Rename’. Additional pages for text, images, or maps can be added to the report by clicking ‘Insert page’ and making the selection.

5.3 Reporting tools and options

Page customization and viewing can be selected using the ‘Reporting’ tab tools and options, shown in Figure 20.

Figure 20. Reporting toolbar and available options for report customization.

5.3.1 Tools

Page magnification and page selection options are available for report viewing preferences, shown in Figure 20. Additionally, the report can include headers and footers, shown in Figure 21. To insert headers or footers, select the ‘Header/footer’ icon under the ‘Reporting’ tab. The header and footer can each include up to (3) of the following: project name, project location, date, prepared for, prepared by, page number, title, custom, or an image. The header and/or footer is applied to all pages of the report with the exception of the title page. The page orientation option in ‘Tools’ enables the report to be created in Landscape or Portrait orientation.
5.3.2 Options

Location maps are included in all reports. The default map is Road view, but can also be displayed in Satellite view by choosing the ‘Satellite’ icon in the Options toolbar. The map can also be zoomed in and out to show a desired aerial view.

5.4 Create output

Once the report is complete, it can be reviewed and distributed using the Output features. Prior to printing, select the ‘Print preview’ option to see the final report. To save the entire report as a file, select the ‘Export’ drop-down, choose ‘Report’, select the file location, and the report will be saved in PDF format. The figures within the report can be exported independently in PNG format by selecting ‘Figures’ under the ‘Export’ drop-down. The generated output can also be distributed via email by clicking the ‘Send email’ drop-down, selecting the desired file type, and adding the outgoing email address(es) to the ‘Email to’ list. This will open the default email client and generate an outgoing message draft including the file as an attachment. By choosing a RETScreen Plus file, the entire project will be exported in (.ret5) format and must be opened within RETScreen Plus program.
5.4.1 Update data

Once the initial building assessment has been setup, the user can continue on-going monitoring by updating data in the existing project. Click the ‘Update data’ option on the Data toolbar, select the file to import, and indicate the data table destination.

Figure 22. Screenshot of the update form function.

The updated data is automatically incorporated into the previously defined report, which can then be distributed in PDF format via email, as shown in Figure 22.

6. User Help and Support

6.1 RETScreen Plus information directory

For RETScreen Plus general information, user guides, and more in-depth explanations of RETScreen features, click the information directory icon located in the upper right corner of the program. The ‘Contents’ tab includes the following sections:
• Centre Overview
• Software & Data
• Training Institute
• Training Material
• RETScreen Help & Contact Us

The help pop-up window also features index and general topic searches, as well as favorites for quick reference.

To speak directly to a representative via phone or email, choose ‘RETScreen Help & Contact Us’ and then choose ‘Questions and Comments Form’. A RETScreen webpage will open within the help window, and contact information is located at the bottom of the page.

6.2 Templates and case studies

Prior to beginning a new project in RETScreen Plus, take note that within the ‘File’ tab on the Menu bar there are several templates and case studies, shown in Figure 23, which serve as guides for various applications.

The templates lay out the formats suggested to determine energy savings for applications with variant energy sources/systems. The case studies offer examples of energy performance assessment of real projects.

Figure 23. RETScreen Plus project template and case study directory.
7. General Procedures for RETScreen Performance Plus

7.1 Pre-feasibility analysis

Assessing the current energy performance of an existing building enables decision support prior to implementation of energy efficiency measures. The following procedure is used:

7.1.1 Data

1. Select climate data for building location.

2. Import or manually enter metered electricity consumption data into new data table.

3. Download NASA weather data from approximately 20 years prior to the analyzed data set through the present. (Historic climate data is needed to calculate consumption/production based on a ‘normal year’.)

4. In the weather data table, add new columns and calculate heating degree days and cooling degree days.

5. Create data table for any additional factors of influence other than weather parameters (i.e. occupancy) for the same time series used in Step 2. The factors of influence contributing to electricity consumption vary depending on the specific processes at work in the building.

6. Merge relevant factors of influence into data table containing electricity consumption data.

7. Export the downloaded NASA weather data to an Excel file and calculate a ‘normal year’ for the parameters that are considered significant drivers by the regression analysis results. Average the 20 years of historical data to create monthly averages of each weather parameter. These 20 year monthly averages can be used with the regression equation to calculate normal consumption for monthly electric data.

7.1.2 Analytics

1. Establish a baseline using a regression analysis over the entire time series of electricity consumption data. The electricity consumption data is the independent variable, and factors of influence are the dependent variables.

2. Generate a cumulative sum (CUSUM) graph using the regression analysis from the previous step. This provides the running sum of differences between actual and predicted energy consumption over the entire time series. It is important to note the scale of the y-axis to ensure the apparent magnitude of inflection points are not misleading. A linear trend in the CUSUM indicates a period of minimal deviation between the difference of the actual energy consumption
and predicted energy consumption. For example, in Figure 24 the initial CUSUM indicates a linear trend from July 2011- July 2012, thus providing a good baseline year for further analysis.

Figure 24. Cumulative sum (CUSUM) of daily electric consumption for a NASA Langley building using the entire data set, time series from February 2011- March 2013, as the baseline.¹⁰

3. Establish a second baseline by generating a regression analysis using the new time series, July 2011- July 2012, identified in Step 2.

4. Generate a cumulative sum (CUSUM) graph using the regression analysis from Step 3, as shown in Figure 25. Investigate points of inflection in order to quantify and identify changes in energy usage/production. Energy savings or losses for the building are quantitatively measured by comparison with the energy consumption predicted using the baseline year.
Figure 25. Cumulative sum (CUSUM) of daily electric consumption for a NASA Langley building using the time series from July 2011- July 2012 as the baseline. This CUSUM indicates a net energy savings of approximately 5,500 kWh over the period from August 2012-March 2013.10

7.1.3 Reporting

1. Generate a report for facility managers.

2. Insert any additional figures or text pages to customize the report.

3. Export the report as a PDF document or RETScreen file.

4. Update the report as needed.

7.2 Performance assessment of new renewable energy technology or energy efficiency measure

Retrofitting new technologies such as photovoltaic (PV) systems into existing buildings is an effective method of energy and carbon reduction. RETScreen Plus can be used to quantitatively assess and provide ongoing tracking of the performance of newly implemented renewable energy technologies or energy efficiency measures. The following procedure is used:
7.2.1 Data

1. Select climate data for building location.

2. Import or manually enter metered electricity consumption data into new data table.

3. Download NASA weather data for the same time series used in the previous step.

4. In the weather data table, add new columns and calculate heating degree days and cooling degree days.

5. Import or manually enter electricity production (i.e. PV production) into new data table.

6. Merge electricity production factors of influence (i.e. daily insolation, maximum temperature, etc.) into the data table created in Step 5.

7. Merge electricity production data with the electricity consumption data table and create a new column for net electricity consumption. The net electricity consumption is the metered electricity consumption – electricity production.

8. Create data table for any additional factors of influence other than weather parameters (i.e. occupancy). The factors of influence, or drivers, contributing to electricity consumption vary depending on the specific processes at work in the building.

9. Merge relevant electricity consumption factors of influence into data table containing net electricity consumption data.

7.2.2 Electricity consumption analytics

1. Establish a baseline using a regression analysis over the entire time series of net electricity consumption data. The net electricity consumption data is the independent variable, and all factors of influence are the dependent variables.

2. Generate a cumulative sum (CUSUM) graph using the regression analysis from the previous step.

3. Establish a second baseline using a regression analysis over the time series of net electricity consumption PRIOR to implementation of the energy efficiency measure.

4. Generate a cumulative sum (CUSUM) graph using the regression analysis from Step 3.

5. Establish a third baseline using a regression analysis over the time series of net electricity consumption AFTER implementation of the new energy efficiency measure.
6. Generate a cumulative sum (CUSUM) graph using the regression analysis from Step 5. Energy savings is quantitatively measured by comparison of electric usage CUSUM graphs prior to and after implementation of a renewable energy technology or energy efficiency measure.

7. Generate a control chart using the regression analysis from Step 5. The control chart shows the variance (% difference) between predicted and actual consumption.

8. Generate a measurement and verification chart using the regression analysis from Step 3. This chart shows the actual energy consumption side by side with the energy consumption predicted prior to commissioning the renewable energy technology or energy efficiency measure.

7.2.3 Electricity production analytics

1. Establish a baseline using a regression analysis over the entire time series of electricity production data, shown in Figure 26. The electricity production data is the independent variable and electricity production drivers are the dependent variables.

![Figure 26. Regression analysis of analysis of daily PV energy production vs. daily solar insolation for a NASA Langley building. The bivariate regression line fit (R^2= 0.87) at nearly 45°, indicates excellent correlation between the system output and solar observations.](image)
2. Generate a cumulative sum (CUSUM) graph using the regression analysis from the previous step.

3. Generate a measurement and verification chart using the regression analysis from the previous step, shown in Figure 27.

![Graph showing cumulative sum with regression analysis](image)

**Figure 27.** Regression analysis of analysis of daily PV energy production vs. daily solar insolation for a NASA Langley building.\(^{10}\) The bivariate regression line fit \((R^2 = 0.87)\) at nearly 45°, indicates excellent correlation between the system output and solar observations.

### 7.2.4 Reporting

1. Generate a report for facility managers.

2. Insert any additional figures or text pages to customize the report

3. Export the report as a PDF document or RETScreen file.

4. The report can be updated on an ongoing basis using the ‘Update’ function, and distributed using the predefined report.

### 8. Conclusion

A tutorial defining the functions of RETScreen Plus and an outline of the general procedure for monitoring and reporting energy performance in buildings has been described. Creating a baseline for predicted future energy usage based on energy drivers such as occupancy, meteorological and solar parameters indicate if the system is performing above or below expectancy. Once monitoring for the building has been set up and properly analyzed through multivariate analysis, a report can be crafted specifically for managers, facility coordinators, or senior decision makers to facilitate energy efficiency decision support.
9. References


RETScreen® Plus Software Tutorial

The monitoring, targeting and verification of a building’s energy usage depends upon many factors one of the most important of which is the local weather and climate conditions to which it’s electrical, heating and air conditioning systems must respond. Incorporating renewable energy systems, including solar systems, to supplement energy supplies and increase energy efficiency is important to saving costs and reducing emissions. Retrofitting technologies to buildings requires knowledge of building performance in its current state and potential future climate state, projection of potential savings with capital investment, and then monitoring the performance once the improvements are made. RETScreen Plus is a performance analysis module that supplies the needed functions of monitoring current building performance, targeting projected energy efficiency improvements and verifying improvements once completed. A tutorial defining the functions of RETScreen Plus and an outline of the general procedure for monitoring and reporting energy performance in buildings is described.

Building energy; Energy; Energy efficiency; RETScreen

STI Help Desk (email: help@sti.nasa.gov)
(443) 757-5802